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With rapid development of technologies in the world, the role of the reverse engineer-
ing is increasing day by day. A growing industry is replenished with new processes 
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1 Introduction 

Reverse engineering is a fascinating field that involves the process of deconstructing and 

analysing a product to understand how it works, with the ultimate goal of replicating or im-

proving upon it. This practice is often used in the technology and engineering industries to 

gain insight into the design functionality of products. By completing this process, reverse 

engineering can help to identify potential weaknesses or opportunities for improvement. 

The thesis’s main goal is to develop the power of 3D scanning technology in the reverse 

engineering process. The process of reverse engineering has become increasingly vital in 

modern manufacturing and design processes. The ability to replicate or improve existing 

designs with greater accuracy and efficiency using the possibilities of 3D scanning technol-

ogy. 

The second important aspect of the work is to apply this technology to create a product 

according to the customer's demand. The object is planned to be carried through the pro-

cess of reverse engineering. Desired design and production capacity are the challenges. 

To overcome these challenges and provide a solution that will satisfy the customer, 3D CAD 

software should be used and scanning techniques applied. 

1.1 Origins of the topic  

In the summer months, the author had to get to know 3D scanning technology closer. The 

main task was to study previous guidance on how to use the scanner and software, get 

familiar with this technology, and update it, so any student can complete the basic pro-

cesses without external knowledge. 

After completing this project, interest in looking for news and information related to the 3D 

scanning technology did not disappear, then at the certain point of time, there was an offer 

from the lecturer Eero Scherman to complete the project with the Fine Art department of 

LAB University of Applied Sciences. The goal of the project was to scan the clay-made 

sculptures, create their models, and create files in the 3D printing suitable formats, then 

create a block text for the LAB UAS website. 

At the same time, a customer with a project on the related topic of reverse engineering 

submitted an offer for the thesis. The main point of the project was the completion of scan-

ning on the certain product, given by the customer and fulfilling the reverse engineering 

process. After meeting with the customer and discussing on requirements of the task, there 

was a decision to complete this project. 



2 
 

 
 

1.2 Problem description  

The customer has requested the completion of a reverse engineering project for a product. 

The customer had several reasons for this request, including the need to improve the exist-

ing design. The reverse engineering process will involve disassembling the product, ana-

lysing its components, and reconstructing its design specifications. 

To complete this project author will need to use a variety of engineering tools and tech-

niques to accurately measure and document the product's components and specifications. 

This project will request attention to detail to ensure that the reverse-engineered product 

meets the customer's expectations and requirements. 
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2 Theoretical information 

2.1 3D scanning technology history 

The first mentions of similar technology appeared when ancient Egyptians made 3D plaster 

replicas of mummy heads. This required materials such as linen and gypsum, which were 

incredibly valuable in ancient societies. At the time, it was possible for them to capture ob-

jects in three dimensions, but it was very time-consuming. 

In 1953, in the United States of America, the military began experimenting with an optical 

measuring system, which used light and high-speed shutters. Later, when technology came 

from government to the civilian usage, laser-measuring systems became popular very fast. 

This point in history is assumed to be called the start of scanning technology. (The evolution 

of 3D laser scanning 2020.) 

Within several years with the fast development of technology around the world, the 3-axis 

Coordinate Measuring Machine was integrated with remote computer control, creating 

faster and more precise possibilities to scan the objects for industrial use. The first applica-

tion of this kind of technology is the scanning of the VW Beetle in 1972 (Figure 1), where a 

car was mapped with polygons and measured using the scanner. The resulting dataset was 

used for a computer program and resulted in the first wireframe model of a car. (Jalopnik, 

2013) 

 

Figure 1. VW Beetle model (Jalopnik 2013) 

In the 1980s, 3D scanning technology advanced rapidly with the development of structured 

light systems. These systems projected a pattern of light onto the surface of an object and 

used cameras to capture the deformation of the pattern caused by the surface. The data 

was then processed to create a 3D model of the object. David Marr and Tomaso Poggio, 

two researchers from the Massachusetts Institute of Technology, were pioneers in this tech-

nology. (Kent A. Stevens, 2012) 
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In the 1990s there was the development of 3D laser scanning systems that used multiple 

lasers to scan an object from different angles simultaneously. These systems were faster 

and more accurate than previous technologies and could scan larger objects such as build-

ings and landscapes. One of the most significant achievements during this period was the 

development of time-of-flight technology. This technology measured the time taken for a 

laser pulse to travel from the scanner to the object and back, enabling the creation of highly 

accurate 3D models. 

One notable scanner among many others is the Cyrax, developed by Cyra Technologies. It 

was the first laser scanner used by surveyors and engineers, and it was portable with its 

own battery, making it easy to carry. When paired with a laptop, the weight of the system 

was around 40kg. The Cyrax had a wide field of view (FOV) of 40° x 40° and could capture 

up to 1200 points per second. It also had a working distance of nearly 50 meters against a 

flat surface. This scanner is shown on Figure 2 . (Scantech international LTD,, 2020) 

 

Figure 2. Cyrax scanner with battery and laptop (Scantech international LTD 2020) 

In the 2000s, 3D scanning technology became more accessible and affordable, and new 

applications emerged. One of the most significant applications was in the field of medicine, 

where 3D scanning technology was used to create digital models of organs for education 

and surgical purposes. The entertainment industry also took part in the promotion of 3D 

scanning technology with created lifelike characters and environments for movies and video 
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games. Figure 3  shows the comparison between real objects and their scanned version. 

(Leica Geosystems, 2020) 

  

Figure 3. Area to be scanned and results of the process (Leica Geosystems 2020) 

Today, 3D scanning technology is ubiquitous and has become an essential tool in many 

industries, including manufacturing, engineering, and design. The technology has evolved 

from early systems that used lasers and structured light to modern systems that use photo-

grammetry and handheld devices. As the technology continues to advance, new applica-

tions will likely emerge, further expanding the potential of 3D scanning technology. Figure 

4 shows the scanning progress with modern scanner and software. (Creaform3D, 2020)

 

Figure 4. Modern scanner in use (Metrologynews 2022) 

2.2 What is reverse engineering 

Reverse engineering is the process of disassembling software, machines, aircraft, struc-

tures, and other products to extract design information. Reverse engineering often disas-

sembles individual components of a larger product. A reverse engineering process can be 

used to determine how a part was designed and created, so that it can be replicated. Com-

panies often use this approach to replace parts that are not available from the original equip-

ment manufacturer (OEM). (Siemens, 2016) 
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Figure 5 shows the reverse engineering process with the basic steps. However, people 

often have limited knowledge of the technical methods used to develop products. The chal-

lenge is, therefore, to gain a working knowledge of the original design by analysing the 

product piece by piece or layer by layer.  

 

Figure 5. Process of reverse engineering (Siemens 2016) 

The process of reverse engineering typically involves several steps. The first step is to an-

alyse the product or system being reverse-engineered in order to gain an understanding of 

its overall functionality and design. This analysis may involve conducting physical tests and 

measurements, examining the product or system's components and subsystems, and re-

viewing any available documentation or schematics. (Siemens, 2016) 

Once the analysis is complete, the next step is to create a detailed model or representation 

of the product that is being reverse-engineered. This model may take the form of a 3D CAD 

drawing or a computer program depending on the nature of the product. This model is then 

used to identify the relationships between the product's various components and subsys-

tems and to determine how they work together to achieve the product’s overall functionality. 

A comparison of the real object to its model version is displayed below on Figure 6.

 

Figure 6. Real and Scanned object (Johanthan Mun 2015) 



7 
 

 
 

In many cases, reverse engineering is conducted using specialized tools and techniques. 

For example, in the field of computer science, reverse engineering may involve using dis-

assemblers and decompilers to examine the source code of a software program in order to 

identify how it functions. Likewise, in the field of mechanical engineering, reverse engineer-

ing may involve using X-ray and CT (Computer tomography) scanning technologies to ex-

amine the internal structure of a product to determine its design. (Techtarget, 2021) 

Companies sometimes use reverse engineering to obtain design data for their products that 

are long out of production. A small company that has been in business for over 40 years 

may have manufactured many products before the advent of computer-aided design and 

digital data storage. So, these old products may be based on long-lost paper plans. Reverse 

engineering allows companies to recover lost designs and create product inventory ar-

chives. Modern scanner during scanning is shown on Figure 7. (Market Prospects, 2022)

 

Figure 7. Scanning of the old automobile with Artec Leo (Artec 3D 2022) 

Overall, reverse engineering is a valuable tool that can be used to gain insight into the 

design and functionality of existing products and systems. Whether used for academic re-

search, product development, or security analysis, reverse engineering plays an important 

role in many fields of study and industry. (Wevolver, 2021) 

2.3 How the 3D scanning works in reverse engineering 

3D scanning is an important technique used in reverse engineering to create a digital model 

of a physical object. This technology involves using specialized equipment that captures the 

surface information of an object in three dimensions. Received data can then be processed 

and used to create a digital representation of the object. The process of the scanning is 

shown on Figure 8. 
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Figure 8. Scanning process with a shoe (Artec3D 2023) 

This process involves several steps, including point cloud generation, surface reconstruc-

tion, and mesh generation. In point cloud generation data points are processed to remove 

any noise and create a clean point cloud. In surface reconstruction, algorithms are used to 

create a continuous surface from the point cloud data. Finally, in mesh generation, a digital 

mesh is created from the continuous surface, which can be used to create a 3D model. An 

example of the mesh data from the scanned object is presented on Figure 9. (Artec3D, 

2023) 

 

Figure 9. 3D scan of a car body (Artec3D, 2022) 

The digital model created through 3D scanning can be used for a variety of applications. 

Reverse engineering involves usage of the digital model to analyse and understand the 

design of the original object. This technique is useful for many industries, including manu-

facturing, where a physical object may need to be recreated or improved upon. The digital 
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model can also be used for quality control and inspection purposes, where the model can 

be compared to the original object to identify any differences. (Artec3D, 2022) 

2.4 Translation 

To complete the reverse engineering processes, it is necessary to use computer-aided de-

sign (CAD) software suitable format while scanning software outcome files usually in stere-

olithography (STL) format. The STL file format is utilized in 3D printing and rapid prototyping 

to depict the surface geometry of a 3D object, this kind of data allows to create the part that 

possesses a visual appearance of the object and not its full properties. Consequently, it 

becomes crucial to convert the STL file to a CAD file for further design and engineering 

adjustments. However, not all 3D CAD software can directly use the STL format. To over-

come such a problem a number of solutions can be used. 

2.4.1 Usage of the translation websites  

To complete the translation process fast and get working file such as STEP. file different 

online conversion tools can be used, on the Figure 10 is the example of uploading on one 

of them. Online conversion tools typically use algorithms to analyse the geometric data 

contained within the STL file and generate a corresponding CAD file.  

 

Figure 10. Dropbox for file (AnyConv) 

After uploading it is important to note that the accuracy and quality of the converted CAD 

file may vary depending on several factors, including the complexity of the original STL file, 

the conversion algorithm used, and the specific CAD format selected. As soon as the trans-

lation is done, the user can download the created file in the required format. 

2.4.2 GeomagicX software 

GeomagicX is a useful tool for reverse engineering processes due to its capability to work 

with scanning format files and the ability to turn them into 3D models. This software provides 
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a variety of tools for designing and modifying models, including parametric modeling, direct 

modeling, and freeform modeling. This software is widely utilized in various industries, such 

as automotive, aerospace, and consumer goods, due to its versatility and powerful func-

tionalities. (Oqton, 2022) 

Below are the basic steps on how to use the addon: 

1.   Create a model in Artec software. 

2.   Go to the “File” tab at the top of the window. 

3.   Move to “Export” and click “Meshes”. 

4.   Open the model in Geomagic. 

5.   Get to the “Meshes” tab. 

6.   Complete recognizing via available features. 

As soon as the steps are done, the user can work with the ready model. This method allows 

to get the most accurate model from the scan, due to direct recognition of the created model 

in ArtecStudio software. How it is seen in the software is shown on Figure 11. (Artec 3D, 

2022) 

 

Figure 11. Example of the file in GeoMagic (Artec3D 2022) 

2.4.3 Usage of FreeCad software 

FreeCAD is an open-source 3D modeling software, that offers a convenient solution to this 

problem. To accomplish the conversion, the user should first import the STL file into 

FreeCAD by selecting "File" > "Import" > "STL". Next, the user should select "Part" > "Create 
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shape from mesh" to convert the imported mesh into a solid shape. After that, the user can 

export the solid shape as a CAD format by selecting "File" > "Export" and choose a suitable 

CAD format such as STEP, IGES, or DXF. FreeCAD provides an efficient and straightfor-

ward method to convert STL files to CAD formats, allowing designers and engineers to use 

a wider range of tools and software to further refine their designs. Below are Figure 12 and 

Figure 13 which present the STL version and created model from it. (MakeUseOf, 2022)

 

Figure 12. STL model in FreeCAD (MakeUseOf 2022) 

 

Figure 13. Model created from the STl file (MakeUseOf 2022) 

2.5 Additive manufacturing 

Additive manufacturing, also known as layer-by-layer manufacturing, is a rapidly emerging 

technology that enables the creation of 3D objects by building up material following its model 

created with different software. This technology has received significant attention in recent 

years due to its potential to revolutionize traditional manufacturing processes by offering 

numerous advantages such as reduced material waste, increased design flexibility, and 

faster product development cycles. (TWI, 2019) 
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Additive manufacturing has been widely adopted across various industries, including aero-

space, automotive, medical, and consumer goods. In academic circles, researchers have 

focused on advancing the technology by developing new materials, improving printing tech-

niques, and exploring its potential applications. (LuxCreo, 2021) 

Overall, additive manufacturing has the potential to significantly disrupt traditional manufac-

turing processes and revolutionize the way products are designed and developed. Imple-

mentation of this technique across a wide range of industries, ongoing research, and devel-

opment efforts, and increasing technical capabilities suggest that additive manufacturing 

will continue to play an increasingly important role in the manufacturing landscape. Figure 

14 shows the creation of part with additive manufacturing. 

 

Figure 14. 3D Printing process (Truventor 2021) 
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3 Completion of the work 

3.1 Preparations for scanning 

Before conducting any scanning, it is important to work with the surroundings, parts, and 

equipment preparations. This may include different procedures and interactions with them 

to obtain better received data and relief of the future modelling processes. 

To achieve the optimal scan quality, additional measures were taken. Product parts were 

cleaned, so there are no dust or other contaminants that may affect the accuracy of the 

scan. Also, the positioning of the object for each scan was thought out, wooden plates were 

used to adjust the height and reduce the amount of surface captured by the scanner, while 

a water-based 3D spray was applied to create a similar and non-reflective surface. 

Another necessary thing that should be mentioned is lightning, scanning area should not be 

dark or overwhelming in the light. Ideally, the object should be placed in a well-lit area with 

uniform illumination. 

Several reference points were marked on the object to help software for future alignment 

processes. The laptop with the necessary software and power cables was positioned to the 

side to prevent them from being captured during scanning.  

Before scanning, the software and equipment proceeded through the calibration tries for 

better performance. Figure 15 shows the working area with equipment. 

 

Figure 15. Scanning area  
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3.2 Scanning process for parts 

3.2.1 Handle 

Once the necessary preparations for the scanning process were completed, the decision 

was made to begin with the handle. To ensure consistency and preserve the graphical in-

formation, the part was positioned vertically and kept in the same orientation throughout the 

scanning process the result is shown on Figure 16. To further improve the quality of the 

data collected, walls were installed behind the handle to eliminate any interference and 

obtain more accurate information on the shape of the object. This allowed to receive the 

scan with satisfying quality for further modeling. 

 

Figure 16. Raw scan of the handle viewed at the the ArtecStudio 16  

3.2.2 Scanning of blade 

To accomplish the proper scanning of the blade, it was decided to use a water-based spray 

on its surface. This created a uniform layer of the material which is not reflective and can 

be scanned easily. Also, the blade was placed vertically, making the tip invisible for the 

scanner and extra scan to complete future model correctly. During the scanning, it was 

mentioned that usage of the background with uniform colour helps the software to process 

data faster with better quality. 

Satisfying scans were received after a number of tries and can be found on Figure 17, 

represented object possess high accuracy in the geometrical and graphical way. It can be 

seen that scans possess a big number of noises that should be removed during further 

processes. 
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Figure 17.Raw scan of the blade  

3.3 Creating and editing models for STL file formats 

After the scans have been obtained, the following action is to align and merge them to-

gether. This is accomplished by using an automatic or manual alignment tool within the 

ArtecStudio software, which matches up shared characteristics in the scans and makes 

necessary adjustments to ensure proper alignment. Once merged, the scans need to be 

cleaned up to eliminate any unwanted artifacts or noise, which can be done using various 

tools available in ArtecStudio. Finally, once the scans have been cleaned up, the user needs 

to create a functional model from them. Side views on the raw scan are shown on picture 

Figure 18. 

 

Figure 18. Merged scans of the handle  
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The "Tools" section in ArtecStudio offers several features for creating a model. To ensure 

the software works correctly, it is advised to use some form of "Registration" before pro-

ceeding to the "Fusion" function. This will enable ArtecStudio to compare the positions of 

each data point and align them to obtain a clear image of the object. The next step involves 

selecting a fusion type and applying it, which may take some time for the algorithms to 

construct a model, the example of the model is on Figure 19. However, it is important to 

note that the algorithms used in the software can sometimes generate undesired parts or 

noises. 

 

Figure 19. First fused model of handle  

The last step in finishing the model involves addressing any issues present. This could 

involve modifying the shape or texture of the model to suit the user's preferences, incorpo-

rating color or other visual details, or using the various functions in ArtecStudio to smooth 

out any rough areas. These tools are useful for enhancing the model's overall appearance 

or removing any elements that might detract from its realism and visual appeal, example of 

the process is shown on Figure 20. 

 

Figure 20. Merged scans to cleaned model  
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3.4 Usage of SolidWorks to work with STL. format file and further modeling 

During the completion of the work, SolidWorks 3D CAD software was the main tool for the 

convertion of the STL files to the functioning model. The SolidWorks software allows user 

to work with STL format files and transform them into solid bodies without any additional 

steps. To complete the translation, the user must select the "Open" tab, choose the desired 

file, click on the "Options" tab, and select "Import as" followed by "Solid Body." After clicking 

"OK" and opening the file, the user can begin working with the meshes immediately. How it 

can be seen in software is presented on Figure 21. 

 

Figure 21. Opening tabs in software (SolidWorks) 

The handle of the product was recreated first, being the most important part. After the suc-

cessful transfer of the STL. file, the author received a visual object with the ability to interact 

with its geometry. An example of the file is shown on Figure 22. 

   

Figure 22. Opened STL file  
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The process of translating a file from one software to another can be successful in terms of 

preserving the overall geometry information of the model. Translated file from Artec soft-

ware was correctly opened in Solidworks, indicating that the translation of the handle model 

was carried out effectively. Consequently, the file can be utilized for further 3D modeling, 

as the geometry information was not lost or spoiled during the translation process. Following 

the steps of the handle translation, the blade of the knife was the next part of the work. After 

a successful process of translation of the files that contain information on these parts with 

the highest accuracy and lowest losses, the work was done at this step. Two models are 

displayed in Figure 23. 

 

Figure 23. Compared models from softwares ( a. SolidWorks, b. ArtecStudio) 

With the result of the processes, files from software can be compared. A comparison be-

tween a translated file from Artec software and Solidworks necessitates considering several 

factors. Artec software is principally designed for 3D scanning and capturing physical ob-

jects, while Solidworks is primarily utilized for developing digital designs from scratch. 

Therefore, a translated file from Artec software may not be as accurate or precise as a 

model created directly in Solidworks.  

Furthermore, the quality of the model in Solidworks may be influenced by the format of the 

translated file. Anyway, using Artec software to capture physical objects can serve as a 

a) 

b) 
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valuable foundation for constructing 3D models in Solidworks. This approach allows for the 

recreation of intricate shapes and structures that may be difficult to create from the scratch. 

The efficiency of using a translated file from Artec software in Solidworks is depending on 

the specific requirements of the project and the precision necessary for the final product. 

During one of the technical meetings with the supervisor, it was decided to accomplish the 

translation only of 2 main parts, where the second is the blade of the product. After the 

successful process of translation of the file that contains information on this part with the 

highest accuracy and lowest losses, the work was done at this step. 

3.5 3D modelling of the product 

In order to achieve the desired shape, a number of sketches were created to replicate the 

geometry of the scanned object. The sketches included the ends of the handle to determine 

the length of the part, as well as sketches from four sides to establish the facets. It was 

important to ensure that all the sketches were interconnected so that the "Lofted boss" fea-

ture could be executed accurately. With the model now created in SolidWorks, it can be 

easily modified in the future. Figure 24 shows the side view of the model. 

 

Figure 24. Handle created with sketches  

The blade of the product is created following the appearance pattern, which means it is 

having two facets on each side that are angled to each other and a cutting-edge pattern. 

With the usage of received dimensions including thickness and length, tang and connec-

tions were modeled. Also, during creation it was necessary to remember, that blade of the 

knife will be created using the machines, which means avoidance of profiles that is hard to 

produce with machinery. The curvature of the blade appeared as a solid problem during 
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modeling due to its strict dimension requirements and visual appearance. After going 

through the problems, the model that represented scans was created, it can be found on 

Figure 25. 

 

Figure 25. Created blade  

The creation of the main parts created a need for modeling the bolster and back plate parts 

to create a future object with all the components. Both of these parts were meant to be 

custom, which means their creation was based on blade and handle geometry. Bolster (the 

part between the blade and handle) had to follow the shape of the handle on its end and fit 

the end of the blade on its surface. While the back plate had only to follow the right end of 

the handle. These geometrical patterns are presented on Figure 26. 

 

Figure 26. Bolster and back plate features  
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With scanned parts and created models, first assembly was created. Also, the accuracy of 

the scanning was checked, according to the dimensions of the original part, models possess 

most of the important geometry with high precision. 4 parts, including: the blade, handle, 

and fixers were connected in the same way as in the project’s product. Figure 27 gives the 

view from the side on the model. 

 

Figure 27. Model with initial parts  

As at it can be seen from the picture above, losses on the handle and bolster during mod-

eling caused the blade to get over the edge. This caused a problem to be fixed in the further 

modeling on both parts, on the other hand, the back plate and end of the handle on its side 

were said to be more accurate to the original fitment and dimensions. 

3.6 Modernisation of the parts and creating adjustments 

Updating and adjusting parts is an essential responsibility in manufacturing that can en-

hance product quality, boost efficiency, and lower expenses. The assigned task involved 

modernisation and creating new parts to meet the needs of customers. During the design 

stage, it is important to consider manufacturing processes to ensure that the parts can be 

produced using machines. This includes modeling and testing the parts to ensure they are 

suitable for efficient production. To ensure that all the changes were correctly understood 

and done, meetings with the customer were arranged frequently.  

After showing the first completed model of the product, the customer requested a more 

secure method of fastening the knife to improve reliability during use. To achieve this, the 

tang geometry was changed to a square shape, and M4 thread was added. To implement 

the idea, a custom screw was developed to cover the thread and the back plate, securely 

fixing the construction in place. This modification will ensure that the knife is firmly attached, 

providing stability and safety during use, overview of the changes can be found on Figure 

28. 
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Figure 28. Tang changes and created nut  

After consulting with future manufacturers, it was determined that changes needed to be 

made to the design of a fixing feature. First, the custom fixer was redesigned, which will be 

screwed onto the thread on the tang, rather than inside of it. A special thread for screwdriver 

was created to make it possible to use. Created part is shown on Figure 29.

 

Figure 29. Custom screwable pin  

Additionally, changes were made to the handle, including the addition of several millimeters 

on the sides with the same shape, as well as cutting the same shape into the bolster and 

back plate. This will provide added stability to the construction by fixing the handle on both 

sides at the tips. Finally, an extra cavity with the shape of the blade was added to the bolster 

to enhance reliability during use. Figure 30 shows the changes in the handle. 
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Figure 30. Handles extra millimetres.  

Finally, an extra cavity with the shape of the blade was added to the bolster to enhance 

reliability during use. Changes in the bolster are displayed on Figure 31.   

 

Figure 31. Cavity on the bolster part. 

Another discussion with the customer identified a small cosmetic issue with the circular 

pattern on the tang. This resulted in a problem where the cavity on the bolster was exposing 

the helve, which was not acceptable. To address this issue, it was decided to divide the 

tang into two separate parts. Figure 32 describes the solution of the problem. 
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Figure 32. Fixed bolster feature 

To join both parts of the tang, a hook was created on one half and a fastening on the other. 

One part is connected to the blade and replicates its geometric pattern, while the other 

maintains a circular appearance with a threaded end that is M5 dimension. This type of 

connection allowed to keep the physical properties of the product as much as its appear-

ance. Figure 33 shows an example of the created scheme. 

 

Figure 33. Connected hooks  
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Later, after the presentation of the hook connection to the customer, it was mentioned that 

this kind of system lacks stability due to a large amount of free space on the sides, also due 

to manufacturing reasons it was decided to change the type of hooks to less angled and 

easier to produce. In addition, the amount of material to be removed from both tangs is 

reduced leading to less manufacturing time and extra reliability to connections.  

Another important thing that was mentioned during the meeting is the material properties of 

the knife. It was important to assign materials to get the approximate values of the weight 

of the product and its center mass. Both parameters are valuable for final customer usage. 

For different parts, different materials were requested (Table 1). 

Part Material 

Handle Oak wood 

Blade Stainless steel 

Circular tang Stainless steel 

Bolster Brass 

Back plate Brass 

Custom pin Brass 

Table 1. Parts materials 

3.7 Prototyping 

Receiving the final version of the product made the author to create the part using additive 

manufacturing technology. All the models were translated into printing type files, suitable 

for PrusaSlicer software. By completing this stage, the author accomplishes the possible 

manufacturing to identify potential problems. PrusaSlicer software with Prusa 3D printer 

was used to produce the parts, PLA plastic with 0.3 mm width wire is the main material. The 

scale of the object is 1:1 to input the possibility to compare it to the original product later. 

The length of the printing and displacement are shown on Figure 34. Prusa software inter-

face. 
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Figure 34. Prusa software interface 

Created parts were assembled to check the durability of the parts under loads. With the 

usage of plastics, the product is shown to withstand basic loads like cutting and chopping. 

From this author assumes that with the usage of metals, the knife will suit as a durable and 

reliable product. Its visual appearance is displayed on Error! Reference source not 

found.. 

 

Figure 35. Assembled prototype 
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4 Review of completed work 

Reverse engineering is a time-consuming and challenging process of extracting and ana-

lysing the design of an existing product. While it has several advantages, such as reducing 

time-to-market, improving product design, and enhancing competitiveness, it is not without 

its struggles. Along the completion of the project, several problems occurred during different 

stages.  

The scanning process of the object was a problem due to the dimensions of the parts and 

equipment limitations. To complete the scanning of the blade, it required the usage of extra 

surrounding parts to create a background or usage of the water-based paint on them, so 

the scanner can collect the data. Calibration of the scanning device took several tries of 

working to be able to collect the data properly with the highest accuracy. 

A minor issue arose during the translation process where a large number of polygons were 

present in the created model after scanning, resulting in a time-consuming process. Despite 

this setback, it was decided to maintain the number of triangles to preserve the dimensions 

of the scanned object with the highest possible accuracy. However, this decision led to 

prolonged processing times, slowing down the overall project completion. 

During modeling, a number of problems appeared. Most of them were related to the correct 

usage of dimensions that were captured by the scanner. Due to the cleaning of the handle 

model in the scanning software, the ends of the object were angled and were not represent-

ing the real object. 

In the above-mentioned problems, the solutions were evident and easy to solve. However, 

the biggest issues occur from the connection of the models. The reason this was the most 

problematic and cumbersome issue stems from the fact that it is caused by an unknown 

reason. As a result, a significant amount of time was spent on solving the problem on time. 

Once this complicated task was completed, the following steps were completed in the more 

efficient way. 

Notes for future projects 

Before the next scanning project starts, it is important to make small research on the object 

and potential problems for the scanner and software. This will allow to decrease time con-

sumption of the process and keep the data as accurate as possible. Among the possible 

solutions after research, the author would like to mention proper lighting for objects, as it is 

a key of the scanning, and the usage of markers on objects or scanned area to make further 

post-processing operations more precise.  
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Another important practice to mention is maintaining proper orientation during the scanning. 

It is crucial to follow the software readings and leads directly to work with 3D modeling 

software. With only these steps among all the other possible preparations, the end result 

will be enhanced a lot. 

Working with files that have high polygons count in 3D modeling can be a challenging task. 

However, there are several ways to overcome the problem. One effective solution that the 

author would use to fulfil the problem is decimation tools that simplify the model by reducing 

the number of polygons while keeping the shape intact. In the case of using only the scan-

ning software, the solution is to use mesh optimization tools that can analyse and optimize 

the geometry of a model to reduce the number of polygons without changing the appear-

ance overall but losing some of the details.  

This is a part of the work, for which it is required to decide what are priorities at the point of 

time, whether it is details of the object or smoothness during the following modeling. Addi-

tionally, it is worth mentioning the possibility of using other add-ins for SolidWorks software. 

One of them is not brought up but could be used in the future as a “ScanTo3D” tool. This 

feature helps the user with the import of the meshes and their further processing with algo-

rithms that recognizes the meshes and creates the surfaces from them. 

Speaking of SolidWorks usage, it is essential to keep the proper orientation during the mod-

eling process to ensure alignment with the STL files for comparison with emerging model. 

When working with the assembly design will be created by utilizing knowledge of mate prob-

lems due to design optimization. Correct creation of mating surfaces or parts with simpler 

geometry will set all the further work to be completed faster due to the availability of fast 

rebuilds. Also, it is crucial to remember of “Mate” and “Smart Mates” features working algo-

rithm, usually it applies the fastest mating type, while the user can think about certain among 

all of them. Another useful feature that can be applied in the future is “Mate Reference”, this 

tool allows to create a specific reference point on the part that can be used for mating later. 

These few things will accelerate the author's future modeling projects. 
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5 Summary 

The objective of this thesis was to investigate the potential use of modern technologies such 

as 3D scanning in the reverse engineering process. Proper utilization of suitable techniques 

and product development practices was expected to facilitate the attainment of the desired 

outcome. However, certain challenges were encountered in the process. 

The study examined the use of 3D scanning for reverse engineering of a knife, with the 

primary aim of investigating the feasibility of this tool in accurately capturing a product's 

geometry and creating a 3D model for reverse engineering. During the study author used a 

structured approach that involves Artec equipment and software utilization, working with the 

scanned object, processing the data to SolidWorks software, and completing the models 

according to the customer demand. 

Moreover, the thesis delved into the specific challenges and considerations encountered in 

reverse engineering of the knives, such as the complex curvature and intricate features of 

knife blades, handles, and other components. It presented various techniques for overcom-

ing these challenges, such as selecting appropriate scanning parameters, aligning, and 

registering multiple scans correctly, and employing data processing techniques for obtain-

ing accurate and complete knife models. 

Finally, the author created 3D model that demonstrates the ideas of reverse engineering 

and customer needs. Properly used 3D scanning software that allowed to extract necessary 

information from the initial object to reconstruct its parts for future modeling. Properties such 

as materials, centre mass and weight of the item are considered to match requirements of 

similar products on the market. Detailed version of the product was designed with required 

drawings to achieve a possibility for future manufacturing.  



30 
 

 
 

References 

AnyConv. 2022. Online file converter. Retrieved on 5 February 2023. Available at 

https://anyconv.com/ 

Ben Lutkevich, 2021. Difinition of reverse-engineering. Techtarget. Retrieved on 14 Febru-

ary 2023. Available at https://www.techtarget.com/searchsoftwarequality/definition/reverse-

engineering 

Creaform3D. 2020. Deep dive into the world of 3D scanners and 3D measurement 

technologies. Retrieved on 20 January 2023. Available at 

https://www.creaform3d.com/blog/explore-3d-scanners-and-3d-measurement-

technologies/ 

Heena Mansuri, 2021. What are the applications of additive manufacturing? Truventor. 

Retrieved on 12 March 2023. Available at https://blogs.truventor.ai/blogs/what-are-the-

applications-of-additive-manufacturing/ 

Jason Torchnisky, 2013. The First Real Object Ever 3D Scanned and Rendered Was a VW 

Beetle. Jalopnik. Reterieved on February 24 2023, Available at https://jalopnik.com/the-first-

real-object-ever-3d-scanned-and-rendered-was-494241353 

John Ashby, 2020. Blockbuster Scanning: Using LiDAR for Joker & John Wick. Leica 

Geosystems. Retrieved on 20 January 2023. Available at https://leica-

geosystems.com/ru/case-studies/reality-capture/blockbuster-scanning-using-lidar-for-

joker-and-john-wick 

Johnathan Mun, 2015. Benchmarking Naval Shipbuilding with 3D Laser Scanning.  

Researchgate. Retrieved on 12 February 2023. Available at 

https://www.researchgate.net/publication/338034997_Benchmarking_Naval_Shipbuilding_

with_3D_Laser_Scanning_Additive_Manufacturing_and_Collaborative_Product_Lifecycle

_Management_October_26_2015_Naval_Postgraduate_School 

Kent A. Stevens, 2012. The vision of David Marr. ResearchGate. Retrieved on 25 January 

2023. Available at https://www.researchgate.net/publication/235626691_The_Vi-

sion_of_David_Marr 

LuxCreo. 2021. Top Seven Industries for Additive Manufacturing Applications. Retrieved on 

20 January 2023. Available at https://luxcreo.com/top-seven-industries-for-additive-manu-

facturing-applications/ 

https://anyconv.com/
https://www.techtarget.com/searchsoftwarequality/definition/reverse-engineering
https://www.techtarget.com/searchsoftwarequality/definition/reverse-engineering
https://www.creaform3d.com/blog/explore-3d-scanners-and-3d-measurement-technologies/
https://www.creaform3d.com/blog/explore-3d-scanners-and-3d-measurement-technologies/
https://blogs.truventor.ai/blogs/what-are-the-applications-of-additive-manufacturing/
https://blogs.truventor.ai/blogs/what-are-the-applications-of-additive-manufacturing/
https://jalopnik.com/the-first-real-object-ever-3d-scanned-and-rendered-was-494241353
https://jalopnik.com/the-first-real-object-ever-3d-scanned-and-rendered-was-494241353
https://leica-geosystems.com/ru/case-studies/reality-capture/blockbuster-scanning-using-lidar-for-joker-and-john-wick
https://leica-geosystems.com/ru/case-studies/reality-capture/blockbuster-scanning-using-lidar-for-joker-and-john-wick
https://leica-geosystems.com/ru/case-studies/reality-capture/blockbuster-scanning-using-lidar-for-joker-and-john-wick
https://www.researchgate.net/publication/338034997_Benchmarking_Naval_Shipbuilding_with_3D_Laser_Scanning_Additive_Manufacturing_and_Collaborative_Product_Lifecycle_Management_October_26_2015_Naval_Postgraduate_School
https://www.researchgate.net/publication/338034997_Benchmarking_Naval_Shipbuilding_with_3D_Laser_Scanning_Additive_Manufacturing_and_Collaborative_Product_Lifecycle_Management_October_26_2015_Naval_Postgraduate_School
https://www.researchgate.net/publication/338034997_Benchmarking_Naval_Shipbuilding_with_3D_Laser_Scanning_Additive_Manufacturing_and_Collaborative_Product_Lifecycle_Management_October_26_2015_Naval_Postgraduate_School
https://www.researchgate.net/publication/235626691_The_Vision_of_David_Marr
https://www.researchgate.net/publication/235626691_The_Vision_of_David_Marr
https://luxcreo.com/top-seven-industries-for-additive-manufacturing-applications/
https://luxcreo.com/top-seven-industries-for-additive-manufacturing-applications/


31 
 

 
 

Market Prospects. 2022. What is Reverse Engineering? Learn About Its Processes and 

Benefits. Retrieved on 25 January 2023. Available at https://www.market-prospects.com/ar-

ticles/what-is-reverse-engineering 

Matthew McMilion, 2019. Slashin weekends off reverse engineering farm equipment with 

Artec Eva. Artec 3D. Retrieved on 18 March 2023.  Available at 

https://www.artec3d.com/cases/reverse-engineering-farm-equipment 

Metrologynews. 2022. Handheld 3D Laser Scanner Launched With Integrated Photogram-

metry. Retrieved on 26 January 2023. Available at https://metrology.news/handheld-3d-la-

ser-scanner-launched-with-integrated-photogrammetry/ 

Samuel L. Garbett, 2022. Converting 3D Printable STL Files Into STEP for CAD. 

MakeUseOf. Retrieved on 24 February 2023. Available at 

https://www.makeuseof.com/converting-3d-printable-stl-files-into-step-for-cad/ 

Sandeep M, 2016. Announcing Solid Edge Reverse Engineering Beta. Siemens. Retrieved 

on 26 January 2023. Available at https://blogs.sw.siemens.com/solidedge/announcing-

solid-edge-reverse-engineering-beta/ 

Scantech International LTD. 2020. Timeline of 3D Laser Scanner. Retrieved on 25 January 

2023. Available at https://scantech-international.com/blog/timeline-of-3d-laser-scanners 

Svetlana Golubeva, 2022. Building a Hellcat-powered ’57 International Metro van with Artec 

Leo. Artec3D. Retrieved on 20 January 2023. Available at https://www.ar-

tec3d.com/cases/scratch-build 

Trimble, 2020. Announcing Solid Edge Reverse Engineering Beta. Retrieved on 4 March 

2023. Available at https://buildingpointohiovalley.com/wp-content/uploads/2020/09/The-

Evolution-of-3D-Laser-Scanning.pdf 

TWI. 2019. What is additive manufacturing? Definition, types and processes. Retrieved on 

12 March 2023. Available at https://www.twi-global.com/technical-knowledge/faqs/what-is-

additive-manufacturing 

Wevolver. 2021. What is reverse engineering? Retrieved on 12 March 2023. Available at 

https://www.wevolver.com/article/what-is-reverse-engineering- 

 

https://www.market-prospects.com/articles/what-is-reverse-engineering
https://www.market-prospects.com/articles/what-is-reverse-engineering
https://www.artec3d.com/cases/reverse-engineering-farm-equipment
https://metrology.news/handheld-3d-laser-scanner-launched-with-integrated-photogrammetry/
https://metrology.news/handheld-3d-laser-scanner-launched-with-integrated-photogrammetry/
https://www.makeuseof.com/converting-3d-printable-stl-files-into-step-for-cad/
https://blogs.sw.siemens.com/solidedge/announcing-solid-edge-reverse-engineering-beta/
https://blogs.sw.siemens.com/solidedge/announcing-solid-edge-reverse-engineering-beta/
https://scantech-international.com/blog/timeline-of-3d-laser-scanners
https://www.artec3d.com/cases/scratch-build
https://www.artec3d.com/cases/scratch-build
https://buildingpointohiovalley.com/wp-content/uploads/2020/09/The-Evolution-of-3D-Laser-Scanning.pdf
https://buildingpointohiovalley.com/wp-content/uploads/2020/09/The-Evolution-of-3D-Laser-Scanning.pdf
https://www.twi-global.com/technical-knowledge/faqs/what-is-additive-manufacturing
https://www.twi-global.com/technical-knowledge/faqs/what-is-additive-manufacturing
https://www.wevolver.com/article/what-is-reverse-engineering-

